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Introduction

Access your store through your app anytime, anywhere. The enterprise version of this extension is
used to manage inventory of products.

Benefits of MageMob Admin

e |t helps to manage your Magento store easily.

e Helps manage customers, orders, products etc.

e  Build a loyal relationship with customers by providing a transparent sales experience.

e  Access anytime, anywhere at work, at home, on the go.

e |tisused increase sales and revenue.

e |t will help you improve the accuracy of inventory orders. Helps you figure out how much inventory you need
to have on hand.

e Helps manage customers & products on the move.

e |tis Useful for keeping track of sales data with graphical representation.

e This inventory Management strategy will help you save time and money. It would help you have real time and
monetary benefits.

e The Barcode scanning module integrated in this system will help you scan the barcode of products and also
enter a unique barcode on your own. The Barcode scanning devices will be configured with the system and
will help eliminate the manual process so that your employees can focus on more important areas of business.

Pre-requisite

e This extension is dependent on default inventory settings of Magento.
e  This can be checked from System - Configuration - Catalog - Inventory.
e  Expand the “Product Stock Options” and set the “Manage Stock” option to “Yes”.

www.appjetty.com
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Installation & Activation

Installation Steps

Step 1: Check Permissions

e Make sure the "app" and "lib" directories of your Magento and all directories inside it have full written
permissions or set permissions on the each directory equal to 777 or 0777.

Important! Change all permissions back after installation.

Read more about permission at
http://www.magentocommerce.com/wiki/magento_filesystem permissions

Step 2: Disable Compilation

e Loginto Magento Admin Panel and go to System - Tools - Compilation and disable the compilation.
e After step 5 you can run the compilation process again.

Step 3: Upload Files

e  Upload all folders from the extension package to the installation directory of your Magento software
using an FTP client.

Filename + Flename -
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;-_l] htacoess, sample

Step 4: Clear cache

e Go to System - Cache Management.
e (Clear the store cache.

Step 5: Re-login

e Logout and log back into Magento Admin Panel.
Step 6: Use Extension

e  Go to System - Configuration.
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In the left column you will see the new tab — Biztech Extensions.

Extension Activation (Ultimate Version)
Stepl: Copy an activation key

e  Copy the activation key from the Order Confirmation Mail. OR

e Loginto your account at www.appjetty.comusing the email and password you have provided at checkout
process.

e Goto Downloadable Options and copy the activation key for the MageMob Inventory extension.

Step2: Activate the extension

e Loginto Magento Admin Panel and go to System Configuration-> Biztech Extensions/MageMob Inventory
Activation and enter the activation key in the "Activation Key" field for the MageMob Inventory extension
then click the “Save Config” button.

MageMob Inventory © Save Config
Inventory System Activation 0

Activation Key \ [STORE VEW]

Select Websites Demo Website [STORE VIEW]
Main Website
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Configuration

Please follow the below steps to configure MageMob Admin extension.

Professional & Professional+ version:

Go to System -> Configuration
In the left column you will see the tab Biztech Extensions -> MageMob Admin.

Step 1: General Configuration

e Enabled: Select "Yes" to enable the MageMob Admin extension. The extension is disabled by default.
e New Order Notification Message: Specify your message which will be received on the Mobile app
whenever a New Order is received.
e New Customer Register Notification Message: Specify your message which will be received on the
Mobile app whenever a New Customer is registered.
e  Minimum Quantity Required For Product: Specify minimum quantity required for product inventory
alerts.
e  Product Inventory Notification Message: Specify your message which will be received on the Mobile app
whenever a product quantity is lower than or equal to minimum quantity.
e  Product Review Notification Message: Specify your message which will be received on the Mobile app
whenever a new product review is added.
e Store Base Url QR code: Displays QR code for store base Url.
Current Configuration Scope: MageMob Inventory
[ Default Config ~ @
Connguration Eoabie Exianmion
> CATALOG Supplier Select
....... Trmmamsis SnmEres e e e e e
e inventory System Enterprise General Configuration
> BIZTECH EXTENSIONS Send MNotification For COrder Notification [STORE “VIEW]

Product Motification
MageMob Inventory

Product Designer

Mew Order Motification hMessage [Mew wicki Whoop! [STORE “1EW]
Enter your message which will be rec sived on the
Mobile app whenewer a Mew Order is received

Mew Customer Register [Mew Customer Whoop! [STORE “1EwW]
MNotification Message Enter your message which will be rec eived on the
Mobile app whenewver a New Customer is registered

Finimum Quantity Required For [1o [STORE “I1EW]
Product Enter minimum quantity required for product inventory

slerts
Product Inventory MNotification |Low Stock Product [STORE “WIEW]
Messags Enter your message which will be received on the

Mebile app whenewver a product gty is lower than or
egual to minimum gty.

Product Review MNotification |Product Rewview [STORE WIEW]
Message Enter your message which will be receied on the
Mobxile app whenever a new product review is added.
Store Base Url http:fmagemob . biztechconsultancy.comindex. phps [STORE “IEW]
Configure this URL on your device.

Store Base Url QRcode [STORE “1EW]

Displays QR code for store base url
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Ultimate Version:

These are some features of MageMob Inventory which are supported with mobile.

e  Go to System -> Configuration
e Inthe left column you will see the tab Biztech Extensions -> MageMob Inventory.

Step 1: Enable Extension

Current Configuration Scope: MageMob Inventory

| Default Config v @
Inventory System Activation
Configuration Enable Extension
» CATALOG
Enabled [ Yes v [STORE VIEW]

Configurable Swatches

Ty Supplier Select
» BIZTECH EXTENSIONS Do you want to show all suppliers |Yes v [STORE VIEW]

MageMob Inventory in PO creation ? » Ifyou select Yes than this will show all suppliers while

generating Purchase order otherwise it will show the
Product Designer

suppliers related to that Products. If no supplier is
selected for product than it will display all suppliers by
default

Advanced Inventory System: Configuration
Inventory System Enterprise General Configuration

Select “Yes” to enable the extension.

Step 2: Select Supplier

e Select “Yes” to show all suppliers in Purchase Order creation.

Step 3: Inventory System Enterprise General Configuration

o  Refer step 1 “General Configuration” of basic version.

Step 4: Mange Suppliers

e  Go to MageMob Inventory - Manage Suppliers. A grid of suppliers (if added) will be displayed. Click on “Add
Supplier” to add new supplier.

www.appjetty.com
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Suppl

Sup

ier Information

plier Information

Add Supplier

Supplier information

First Name *

Last Name *
EMail *
Password *
Company *
Contact Person
Shipment Methad

Fayment Method

Status

[ Inactive

User can add basic details of the supplier such as his name, email, company name, contact person’s
name, shipping method and payment method.

User can select the status of the supplier as “Active” or “Inactive”.
User can add detailed address of the supplier including city, state, country and postal code.
The user is allowed to enter only one address per supplier.

Manage Suppliers
Page |1 | offpages | View [20 v perpage | Tota 4 records foung w
Select Al | Unselect Al | Select\isble | Unselect Visible | 0 items selected Actions Al m
m Supplier Name First Name Last Name EMail Contact Person Status
Any v l_ ‘ | [ v
B |5 US Supplier Usfn USIn qa0i11.www@amail.com US Supplier Active
o 4 Indian Supplier fname Iname 1gawww@gmail.com Indian Supplier Active
o 3 demo demofn demaln qa’ www(@gmail.com Active
o 1 Test Developer Developer developert test@amail. com Active
e User can associate products to a particular supplier which he frequently buys from that supplier.
e  (Click on “Save Supplier” button. The supplier details will be added in the grid.
www.appjetty.com 6
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Step 5: Manage Stock

e |t allows the admin to increase / decrease the quantity of the product rather than giving total quantity. The
increased / decreased quantity will be directly reflected in selected warehouse.

e The warehouse can be selected from button given in the panel.

e They can also export these products in csv format but the decreased quantity must not be more then total

available quantity in warehouse.

oot ot

Manage Stock
Select Warehouse: | Venetory v
Fage ,1_ | of 14 pages | View |20 v | perpage | Total 266 records found E
SekectAl | Unsslect Al | Select Visble | Unselect Vs | Oems seected s Update Ivenoy v [ET0T
m Image Name SKU Attrib, Set Name  Price Avail. Qty Warehouse Qty Total Qty InciDec Qty Stock Status Comment Statu
Any v ‘ v From: | From: ‘ v o
To: To:
0 910 TestSimple fest_simple Default $100.00 990009 Venetor: | |[inorease Gty v [RISIOGRN Enatl
999999
A
0 909 testconfigurable green test_configurable_green_m Defaut $100.00 wge Vension: | |[incresse oy v |HiRIGHOGKA Ena
0009
A
e testconfigurable green test_configurable_areen Default $100.00 woon vensio: | |[increaseCty. v | [iRIGEGERH Enabl
9999
P
Step 6: Pending Orders
e  Go to MageMob Inventory - Pending Orders. This grid shows pending sales orders (orders in which one
or more of the products are backordered).
Admin can also generate purchase orders by selecting the sales order they want.
More than one sales order can be selected to generate purchase order.
Pending Products
Page ’1_ of 1 pages | View |20 v | perpage | Total  records found W
Select Al | Unselect Al | Select Visible | Unselect Visible | 0 items selected Actions | Generate PO v ﬁ
(07 image Neme SKU Price Avail. Gty Warchouse Gty Stock Availabiity  Status
Any v ‘ From: ‘ From: ‘ v v
To: To:
Elizabeth Knit Top WokD12 521000 1/ Venetory: 1 In Stock Enabled

0 294 x
. |

www.appjetty.com
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Step 7: Purchase orders

e  Go to MageMob Inventory - Purchase Orders. Admin can select products or orders to generate purchase

orders. Click on “Create PO” to generate new PO.

Purchase Orders

Page |1— of1pages | View |20 v perpage | Total7 records found

Select Al | Unselect Al | SelectVisble | UnselectVisble | 0items selected

’ﬁ Purchase Order# PO Order Date Supplier Sales Order # Total PO Order Status Invoice £ Action
E | | Fomg | \ v Fom: [ | \ v
To: & ’— To: l—

0} 7 PQ-100000007 QOct7, 2016 31243 AM fname Iname 5200000 Processing View Create SR
O [ PC-100000008 et 7, 2016 3.06:29 AM fname Iname 5200000 Pending

0o 3 PC-100000005 (et7, 2016 2:36:20AM fname Iname $500.00 Completed IN-PC-100000005 View

O 4 PC-100000004 QOct2, 2016 11.00:40 PM Developer Developer $000 Completed View

0} 3 PC-100000003 Qct2, 2016 10:45:18 PM Developer Developer 59000 Completed INV-PG-100000D View

O 2 PC-100000002 (Oct2, 2016 10:44:50 PM Developer Developer §000 Canceled View

O 1 PQ-100000001 (Oct2, 2016 10:37:39 PM Developer Developer $1.801.40 Processing View Creale SR

e They can select the supplier they want for each of the individual products.

e Purchase orders are generated based on the supplier selected i.e. if you select two or more products from
the same supplier then the “Required quantity” would be added and the “Unit cost” would be the average

of all the individual product costs.

e When you click on “Submit” button, you can review your Purchase Order.

Create Purchase Order aBack
Add Product for Purchase order
Fage ’1_ v of 26 pages | View ’207!' per page | Total 513 records found Reset Filter | Search
Select | ID | Name SKU Quantity Available Supplier Warehouse Unit Cost Row Total
v [ Fom: |
To: ,7
o 90 Test Simple test_simple 999999.0000 |Developer Developer ¥ | [Venetory v | $0.00 0.00
o 909 test configurable green test_configurable_green_m  9999.0000 ‘ Developer Developer ¥ \Venetory v | %000 000
¥ 908 test configurable green test_configurable_green | 9999.0000 ‘ Developer Developer ¥ \Venetory v | $0.00 0.00
o907 test configurable blue Developer Developer ¥ | [Venetory ¥ | $0.00 0.00
O 905 Plaid Cotton Shirt-Royal Blue-L Quantly ’547 demofn demeln v \Venetory v | $0.00 0.00
0 904 Plaid Cotton Shirt-Royal Blue-M Developer Developer ¥ | [Venetory v | $0.00 0.00
0o e Plaid Cotton Shirt-Royal Blue-S Developer Developer ¥ | v | $0.00 0.00
o 9 Plaid Cotton Shirt-Red-L ﬁ ﬁ Developer Developer ¥ | [Venetory v | $0.00 0.00
o 901 Plaid Cotton Shirt-Red-M ms]006c-Red-M 110.0000 |Developer Developer * | [Venetory v | $0.00 0.00
o 90 Plaid Cotton Shirt-Red-5 msj006c-Red-S 100.0000 | Developer Developer v | v | $0.00 0.00
o 89 Plaid Cotton Shirt-Khaki-L msj006c-Khaki-L 99.0000 | Developer Developer ¥ | | v | $0.00 0.00
O 898 Plaid Cotten Shirt-Khaki-M ms]006c-Khaki-M 99.0000 | Developer Developer v | v | $0.00 0.00
o 8 Plaid Cotton Shirt-Khaki-5 msj006¢-Khaki-5 100.0000 | Developer Developer v | v | $0.00 0.00
o 8% Elizabeth Knit Top-Royal Blue-L wbk012c-Royal Blue-L 100.0000 | Developer Developer v | v | $0.00 0.00
o 8% Elizabeth Knit Top-Royal Blue-M wbk012c-Royal Blue-M  100.0000 | Developer Developer v | v | $0.00 0.00
[ 834 Elizabeth Knit Top-Roval Blue-S wbk012c-Roval Blue-S___100.0000 | Developer Developer v | x 1 $0.00 ] 1000 |

e Admin can enter required date, comments, shipping method and payment method once the purchase orders

are sorted by supplier.

www.appjetty.com
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Step 8: Stock Received

e  Go to MageMob Inventory - Stock Received. Admin can enter received quantity as per purchase order of
the product.

e  Admin can also make comment if any and can also add shipping cost.

e Admin has rights to change the purchase order status to partial or complete.

Stock Received
O Gockimewdd PwchmeOde!  Swp  Fudecilse S0 Mashose Oy (yfec.  UndCost Sab Yol SwpegCod ol Fec. By Sinck Receved Dade PO (ndes §
v v Fromc From: Froe: From: Feame =
T ] T ] ®:
POIO000000T e Semmoverent arflS el ] 1 HO [T fuli] S40000 dewioper! uEgrmlrom Jnd MNT1435  Proosseey
hame oo Waks ]
Swesn Movemen! S ] d joniln] 5800 00 B0 M0 Jan 3 70T Pendng
Sports Wk Ll
Swess Mhvemenl ac008  Venelory 5 2 0050 §530 06 001 SB0000 cewsloper] diBoral com Oci? MHEIMT  Processey
Spors Waket A
Swess Mo ey § i 0000 §1.200.00 00 S1HG00 cewsioper! EsBoraicom Oct? MI6IM5E  Processey
Spors A
SengTme x4 ey M 5 Wil L0500 pr-1ii} 25000 dewaiopert Bugrmioom Oct7 ANEXSAN  Compise:
Earees ]
SengTme  afld ey M c H 535,00 freli] S5000 ceveboper! esifipral rom
Eamrgs
EH oper SeingTme Gl Venely 1 m H00 = 5500

Eammes

et Gwislbverent Pl ey O 1 00 s 0 S50

B Sports Wakc
oper Padloin msgli¥c- Versiney b | ] fam 5800 b1 000 ceweioper! Esiforal rom
B SetRedd FEs-Y ET]

et SwimMboverent ac0lf ey W | $1000 N 1] SHED0 dewsioper! siorail rom et 2018
e Spors Wakch e

Stock Received | PO-100000010 < Back

Image Name SKU Supplier Warehouse ~ Unit Cost Quantty Purchased Quantty received Row Total

Plaid Cotton Shirt-Royal Blue-L msj006e-Royal Blue-L demofn demeln Veretory V| 50 DD 0 0 143000

Additional Information Order Totals

Stock Received ' Subloidl  $143000
Comment

e Shipping Cost

Grand Total ~ $1430.00

www.appjetty.com
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Step 9: Purchase Invoice

e  Go to MageMob Inventory - Purchase Invoice. Admin can generate purchase invoice per purchase order.
e Admin can add comments to it.

ltems Invoiced

Name SKU Quantity Purchased Quantity Received Unit Cost RowTotal
Swing Time Earings acj004 10 10 §50.00 §450.00
Supplier: fname Iname Subtotal  $450.00
Invoice Comments:  NIA Shigping Cost~ $50.00
Purchase Order ID:  PO-100000005
. ) TaxAmount  $0.00
Invoice Status Pending

Discount ~ $0.00
Grand Total ~ $500.00

Purchase Invoice
Page |17 of 1pages | View |20 v perpage | Total 2 records found Reset Filler ﬁ
SelectAll | UnselectAll | SelectVisile | Unselect Vistle | Oilems selected Actions v -

’Tl Invoice # Purchase Order # Supplier Sub Total Shipping Cost  Total Inv. Status Action
Any v l_ ‘ \ v Fom: ‘ From: ‘ From; ‘ | v
To: ‘ To: ‘ To: ‘

0 2 INVPOC-100000005 P0-100000005 fname Iname $450.00 $50.00 $500.00 Pending View

0 1 INvPO-100000003 PO-100000003 Developer Developer 35000 $0.00 $100.50 Pending View

INV-PQ-100000005 | Jan 04, 2017 08:50:41 AM ¢ Back

Step 10: Manage Warehouse

e Go to MageMob Inventory - Inventory Warehouses. A grid of warehouses will be displayed from where
warehouses are searched or created.

e  Basic details of warehouses are displayed and is the warehouse primary or not is shown.

Warehouses S—
Page r o fpages | View 20 v perpage | Tofd 3rcards found Reset File
] + Warhause Name City State Country Status Primary Warefouse Action
] | | | '
! Brand Dept Lenea United States Enble o Edt
] sy Huntsvil United States Enble o Edt
f Venetoy Adamsylle United States Enble Yes Edt
www.appjetty.com 10
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Magento‘Admin Panel ogged in as admin | Thursday, March 10,2016 | Log Out

]
Dashhoard Sales Catalog Customers Promotions Newsletter CMS Magemobcart MageMob Inventory Reports System @ Get help for this page

© Latest Message: Reminder: Change Magento's defaut phone numbers and callouts before site launch

Warehouse Information Edit Warehouse 'Dev Aurum' < Back h@.»'“ d » Save
Associated products

Warehouse Name * Dev Aurum

Telephone * 079-7777777

Street* Francis

City* Ahmedabad

Country* India |
State * Gujarat

Postal Code * 380000

Status Enable =l
Primary Warehouse I |

e Admin can associate products to warehouse with necessary quantity.

Magentor Admin Paned R

Dashboad | Saes  Catap  Cuseress | Premebans | Mewsieter  CWE Mspenodcat | Aageblshmwenmery Peports  Sysiem

W Lates i Mevsage: Pamrcer (hangs Magenks § Sefadl phoss rusbess o callogts befen i bench Viou el I citicdl, § iy, B e e 750 rosic i rei g s

Warehause ifomaian Edit Warshause Tev Aunam Back M MLM

Assciaied products

e |1 ol 1pages | Wiew |10 = perpage | Tolad sebords oind . 'i i

¥ e 50 Frie Pasima Quamtty  Wathouss iy
s vl From Frenc
Te; LH
o it LHEE T b BD il 11
o lesipodud 2 tesd praduct 2 $10 33 Bl bk H
o aspeodut13 el pdect1d flE Bio 150m s
o lesifanipaadud 281 denl pradec R B0 LT T}

Step 11: Manage History

e Go to MageMob Inventory -» Inventory Log. A grid of products altered using any action will be displayed.
e When the quantity of product is altered, it is traced here.

e Admin can get the idea of the product quantity, whether it is increased or decreased.

e |t will keep a track from where & how much quantity of any product is altered.

www.appjetty.com 11
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Inventory Log

Page 1 »| of Gpages | View |20 v | perpage | Total 177 records found

SelectAll | UnselectAll | SelectVisible | UnselectVisible | 0items selected

[Search |
Act\ons’iv ﬁ

ID | SKU System Action Action Type Quantity Before Quantity Processed Final Quantity War. Qty Before War. Qty After Additional Info. Processed Date Interface User
[Ang > [ \ * | \ | \ | \ From: ] | [l
To: [F ’7

a 177 msj001 Goods Received  Quantity 25 10 35 1} 0 Jan 19, 2017 7:56:08  Admin Developer
Increased PM User

a 176 msj001 Warehouse Quantity 25 25 25 25 35 Venetory Jan 19, 2017 7:56:07  Admin Developer
Transaction Increased PM User

O 175  msj009 Goods Received Quantity 20 2000 2020 0 0 Jan 19, 2017 7:47:54  Admin Developer
Increased PM User

O 174 msj009 Warehouse Quantity 20 2000 2020 20 2020 Venetory Jan 19, 2017 7:47:54  Admin Developer
Transaction Increased PM User

O 173 msj009 Goods Received Quantity 0 20 20 1} 0 Jan 19, 2017 7:46:40  Admin Developer
Increased PM User

a 172 msj00% Warehouse Quantity 0 20 20 o 20 Venetory Jan 19, 2017 7:46:40  Admin Developer
Transaction Increased PM User

a 17 test_configurable_green_m Manage Stock Quantity 9989 10 9939 1} 0 Jan 19, 2017 7:39:30  Admin Developer
Increased PM User

[0 170 test_configurable_green_m Warehouse Quantity 0 10 10 0 10 Waresy Jan 19, 2017 7:33:29  Admin Developer
Transaction Increased PM User

[ 169 test simple IManage Stock Quantit 300 10 310 0 0 Jan 19 201773943 Admin Developer

Quick Notes

Basic Version:

e php_soap and php_openssl PHP extensions should be enabled.
Login with your created “Magento” user credentials to use our app.
To ensure smooth working of this extension you need to download this extension in your website and
also download MageMob Admin on your device from Play Store or App Store.

App Store link: https://itunes.apple.com/us/app/magentomobilemanager/id695074519?mt=88& ign-

mpt=u0%3D4

Play Store link : https://play.google.com/store/apps/details?id=com.biztech.magemobadmin

Ultimate Version:

e  Productsin all the modules of MageMob Inventory will only be visible if they are assigned to the
website selected while purchasing the Extension.
e Limit of quantity of product to be out of stock is configured from Magento admin.
e In Pending orders only those sales orders will be displayed which are placed from the store/website
selected at the time of purchasing Extension.
e If same products are there in more than one pending orders selected for generating purchase orders, then
you can remove the product from selection otherwise it will take the average of the unit cost entered for
that product based on the summation of the required quantity entered.

www.appjetty.com
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Contact Us

We simplify your business, offer unique business solution in digital web and IT landscapes.

—

Live Chat

e Get instant support with our Live Chat.
e Raise tickets for your specific question!
e Visit our product page at:
https://www.appjetty.com/magento-magemob-
admin.htm and click on the Live Chat button for instant login to my account www.appjetty.com and click on
support. My Support Tickets on your account dashboard, to get

e Send an email to support@appjetty.com or you can

answers to your specific questions. Our team will work to
respond to your query prompt.

Customization:

e [f you would like to customize or discuss about additional feature for MageMob Admin, please write to
sales@appjetty.com

www.appjetty.com 13
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